
    Գ Ն Ա Հ Ա Տ Մ Ա Ն    Ե Վ   Թ Ե Ս Տ Ա Վ Ո Ր Մ Ա Ն   Կ Ե Ն Տ Ր Ո Ն 

 

ՆԱԽՆԱԿԱՆ ԵՎ ՄԻՋԻՆ ՄԱՍՆԱԳԻՏԱԿԱՆ 

ՈՒՍՀԱՍՏԱՏՈՒԹՅԱՆ ՄԱՆԿԱՎԱՐԺԻ ԱՏԵՍՏԱՎՈՐՈՒՄ 

 

 

2025 

 

ԳՐԱՖԻԿԱ 

 

ԹԵՍՏ 4 

 

 

                                                                                   ԽՄԲԻ ՀԱՄԱՐԸ 
 

                                                                         ՆՍՏԱՐԱՆԻ ՀԱՄԱՐԸ 

 

 

Հարգելի՛ ուսուցիչ 
 

Խորհուրդ ենք տալիս առաջադրանքները կատարել ըստ հերթականության: 

Ուշադիր կարդացե՛ք յուրաքանչյուր առաջադրանք: Եթե չի հաջողվում որևէ առաջադրանքի 

անմիջապես պատասխանել, ժամանակը խնայելու նպատակով կարող եք դրան 

անդրադառնալ ավելի ուշ: 

Թեստ-գրքույկի  էջերի  դատարկ  մասերը  կարող  եք  օգտագործել  սևագրության  

համար: 
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Ի՞նչ հիմնական գործառույթ ունի Dictate գործիքը Microsoft Word ծրագրում։ 
 

1) Օգտագործողի խոսքի վերածում տեքստի  

2) Ստեղնաշարային հրամաններով տեքստի խմբագրում   

3) Տեքստի թարգմանում այլ լեզուներով 

4) Տեքստի բարձրաձայն ընթերցում  

 

 

Ի՞նչ նպատակով է օգտագործվում Pivot Table-ը Microsoft Excel ծրագրում։ 
 

1) Մեծ աղյուսակներից տվյալների ամփոփման, վերլուծության և 

խմբավորման համար  

2) Տվյալների ավտոմատ գեներացման և աղյուսակի տողերը թաքցնելու 

համար  

3) Տվյալների տեսքն ու ձևաչափը փոխելու համար՝ ներառյալ գույներն ու 

բջիջների ոճերը 

4) Տվյալների պատահական դասավորություն ստեղծելու համար 

 

 

Ի՞նչ նպատակով է փաստաթղթում տեղադրվում Watermark-ը: 
 

1) Փաստաթղթին ավելացնում է ֆոնային պատկեր կամ տեքստ՝ նշելու 

գաղտնիությունը կամ հեղինակային պատկանելությունը  

2) Փաստաթղթի լուսանցքներում ավտոմատ տեղադրում է հեղինակի 

ստորագրությունը՝ վավերականությունը հաստատելու համար 

3) Փաստաթղթի բոլոր էջերի վրա կիրառում է թափանցիկ պաշտպանիչ 

ծածկույթ՝ տպագրության ժամանակ թանաքը խնայելու համար 

4) Փաստաթղթի վերնագրի ֆոնն է փոխում՝ ավելացնելով դեկորատիվ 

տարրեր՝ վերնագիրը դարձնելով տեսանելի 

 

 

Adobe Photoshop ծրագրի ստանդարտ ֆիլտրերը (Filter) ո՞ր Bits per Channel (RGB) 

ռեժիմում են հասանելի միայն սահմանափակ ֆունկցիաներով:  
 

1) 16 Bits/Channel  

2) 32 Bits/Channel  

3) 24 Bits/Channel 

4) 8 Bits/Channel 
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Adobe Photoshop ծրագրում նշվածներից ո՞ր ֆայլային ֆորմատը չի պահպանում 

ստեղծված նախագծի բոլոր խմբագրվող շերտերը (Layers), թափանցիկությունը և 

այլ հատկությունները։ 
 

1) PSB 

2) TIFF 

3) JPEG 

4) PSD 

 

Adobe Photoshop ծրագրում նոր փաստաթուղթ բացելիս ո՞ր հրամանը Document 

Properties-ի (New Document) պարամետր չէ: 
 

1) Color Profile 

2) Text Alignment   

3) Background Contents 

4) Pixel Aspect Ratio 

 

 

Adobe Photoshop ծրագրում նշվածներից ո՞ր գործիքն է թույլ տալիս ընտրովի 

ավելացնել պատկերի որոշակի հատվածների գունային հագեցվածությունը 

(Saturation)։ 
 

1) Burn Tool 

2) Sponge Tool      

3) Dodge Tool 

4) Smudge Tool  

 

 

Adobe Photoshop ծրագրում  նշվածներից ո՞ր գործիքն է թույլ տալիս ընտրության 

(Selection) եզրերը փափկացնել, հղկել՝ առանց շերտի բուն բովանդակությունը 

փոխելու։ 
 

1) Edge Grow Selection 

2) Transform Selection 

3) Quick Mask  

4) Select and Mask  
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Adobe Photoshop ծրագրում ո՞ր գործիքն է թույլ տալիս ավտոմատ լրացնել 

ընտրված տարածքը՝ վերլուծելով շրջակա գույնը և կառուցվածքը։ 
 

1) Smart Fill Tool  

2) Texture Fill Tool  

3) Content-Aware Fill  

4) Paint Bucket Fill 

Adobe Illustrator ծրագրում ո՞ր գործիքն է օգտագործվում վեկտորային կորերը և 

կառչող կետերը (Anchor Points) խմբագրելու համար: 

1) Mash Warp Tool 

2) Direct Selection Tool  

3) Raster Curve Tool 

4) Pixel Smudge Tool 

 

Adobe Illustrator ծրագրում ի՞նչ գործողություն է կատարում Embed հրամանը ։ 

1) Կպցնում է ֆայլը փաստացի ֆայլի մեջ, դառնում է անկախ արտաքին 

աղբյուրից  

2) Փոփոխում է պատկերի չափսերը՝ առանց որակի կորստի, պահպանելով 

պիքսելները 

3) Վերափոխում է ֆայլը վեկտորային ուղիների, առանց տվյալների կորստի 

4) Պատկերը վերածում է Smart Object-ի, որպեսզի պահպանի առանձին շերտ 

 

Ո՞րն է Blend Tool գործիքի հիմնական կիրառությունը Adobe Illustrator ծրագրում: 

1) Փոխում է օբյեկտի խառնման ռեժիմը՝ ստորին շերտերի հետ գունային 

համադրություն ստանալու համար 

2) Միավորում է ընտրված բոլոր օբյեկտները մեկ ամբողջական եզրագծի մեջ՝ 

ջնջելով հատվող մասերը 

3) Ստեղծում է միջանկյալ պատկերներ երկու կամ ավելի օբյեկտների միջև՝ 

ապահովելով գույնի և ձևի սահուն անցում 

4) Ստեղծում է ցանցային կառուցվածք (Mesh), որի կետերը թույլ են տալիս 

լոկալ փոփոխել օբյեկտի գույնը 

 

 

9  

10  

11  

12  



5 
 

Ի՞նչ է անում Opacity Mask-ը Adobe Illustrator ծրագրում: 

1) Ավելացնում է շերտ, որը փոխում է էֆեկտը միայն մեկ ուղու վրա 

2) Ավելացնում է շերտ, որը վերահսկում է օբյեկտի վրա դիմակի Clipping Path-ը 

3) Ստեղծում է շերտ, որը վերահսկում է օբյեկտի թափանցիկությունը  

4) Ստեղծում է շերտ, որը փոխում է օբյեկտի գույնը ըստ CMYK-ի 

 

 

Adobe Illustrator ծրագրում ի՞նչ գործողություն է կատարում Touch Type Tool-ը: 
 

1) Թույլ է տալիս կիրառել հեռանկարային ձևափոխում ամբողջական 

տեքստային բլոկի վրա 

2) Թույլ է տալիս յուրաքանչյուր տառ առանձին ձևափոխել,  պտտել կամ 

տեղաշարժել  

3) Փոխակերպում է տեքստը վեկտորային գծերի՝ հնարավորություն տալով 

ձևափոխել  

4) Ավտոմատ փոխում է ամբողջ տեքստի տառերի միջակայքը՝ դասավորելով 

կորի երկայնքով 

 

 

Ո՞րն է Shaper Tool գործիքի հիմնական գործառույթը Adobe Illustrator  ծրագրում: 
 

1) Միավորում է իրար մոտ գտնվող օբյեկտները՝ավտոմատ ստեղծելով  մեկ 

ընդհանուր վեկտորային օբյեկտ 

2) Մոտավոր նկարած ձևերը ավտոմատ ճանաչում և վերածում է ճշգրիտ 

վեկտորային պատկերի   

3) Հարթեցնում է վեկտորային կորերը՝ ավտոմատ նվազեցնելով կառչող 

կետերի քանակը 

4) Թույլ է տալիս տեղաշարժել և պտտել վեկտորային օբյեկտները՝ 

օգտագործելով կառչող կետերը 
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Ի՞նչ տարբերություն կա Group  և Combine հրամանների միջև CorelDRAW  

          ծրագրում։ 
 

1) Combine-ը դասավորում է օբյեկտները կողք կողքի, իսկ Group-ը ինտեգրում 

է դրանք միմյանց հետ 

2) Group-ը միավորում է օբյեկտները առանց ձևերը փոխելու, իսկ Combine-ը 

դրանք միաձուլում է մեկ վեկտորային օբյեկտի  

3) Group-ը վերացնում է օբյեկտների գույները, իսկ Combine-ը պահում է միայն 

ուրվագիծը՝ գծի հաստությամբ 

4) Group-ը օբյեկտները միավորում է ռաստերային պատկերի մեջ, իսկ 

Combine-ը՝ վեկտորային միաձուլման համար 

 

 

CorelDRAW ծրագրում ո՞ր հրամանն է կիրառվում տեքստը վերջնական 

վեկտորային կորերի (Curves) փոխարկելու համար: 
 

1) Object > Convert to Curves  

2) Object > Rasterize Text 

3) Arrange > Rasterize Weld 

4) Arrange > Convert to Object 

 

 

Աքսոնոմետրիկ պրոյեկցիայի ո՞ր տեսակի դեպքում են առանցքներից երկուսի 

մասշտաբային գործակիցները հավասար, իսկ երրորդինը՝ տարբեր դրանցից: 
 

1) Տրիմետրիկ պրոյեկցիա 

2) Կովալյեր պրոյեկցիա 

3) Դիմետրիկ պրոյեկցիա 

4) Իզոմետրիկ պրոյեկցիա 

 

 

Ի՞նչ է նշանակում Rendering-ը 3D մոդելավորման մեջ: 
 

1) Տեսարանում լույսերի և տեսախցիկի տեղադրման նախնական 

աշխատանքը՝ մինչև վերջնական արդյունքի գեներացումը 

2) 3D տեսարանից վերջնական 2D պատկեր ստանալը՝ լուսավորության, 

ստվերի, նյութերի և էֆեկտների հաշվարկով  

3) Մոդելի պոլիգոնների թվի օպտիմալացումը՝ տեսարանի 

արտադրողականությունը բարձրացնելու համար 

4) 3D տեսարանի Shading Network-ների Real-Time հաշվարկն ու Compile-ը՝ 

Viewport-ի աշխատանքը արագացնելու համար 
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Ի՞նչ է Rigging-ը 3D մոդելավորման մեջ։ 

 

1) Գագաթների և եզրերի ավտոմատ կապակցումը՝ ձևափոխության համար 

2) Մոդելի նյութերի աստիճանակարգային կապակցումը 

3) Տեսարանի լուսավորման կարգավորումների և վերարտադրման 

նախնական կազմավորումը 

4) Մոդելին կմախք (ոսկրեր) և կառավարման համակարգ ավելացնելը՝ այն 

անիմացիայի համար շարժուն դարձնելու նպատակով   

 

Տրված ո՞ր 3  ֆայլային ֆորմատներն են պահպանում թափանցիկությունը 

(Transparency) Adobe Photoshop ծրագրում: (3 միավոր) 

1. PPM 

2. DNG 

3. RAW 

4. JPEG 

5. PNG  

6. GIF  

7. BMP 

8. PSD  

9. PGM 

 

Adobe Photoshop ծրագրում նշվածներից ո՞ր 3 գործողություններն են թույլ տալիս 

մի քանի շերտեր միաժամանակ կապակցել, խմբավորել կամ կառավարել՝ առանց 

դրանք ձուլելու:  (3 միավոր) 

1. Convert to Dynamic Object 

2. Clip Join Layers 

3. Layer via Copy 

4. Convert to Smart Object  

5. Link Layers  

6. Group Layers  

7. Merge Layers 

8. Merge Visible 

9. Flatten Image 

 

 

20  

21  

22  



8 
 

Նշվածներից ո՞ր 3 գործողություններն են Adobe Illustrator ծրագրի Pathfinder 

գործիքների շարքում։ (3 միավոր) 

 

1. Divide  

2. Intersect 

3. Join Tool 

4. Exclude  

5. Create    

6. Merge Layers 

7. Rasterize 

8. Flatten Transparency 

9. Gradient Mesh 

 

 

 

 

 

Նշվածներից ո՞ր 3-ում են  ճիշտ տրված Adobe Illustrator ծրագրի գործիքների և 

հրամանների նկարագրությունները: (3 միավոր) 

1. Recolor Artwork-ը դնում է Overlay Gradient բոլոր օբյեկտների վրա։ 

2. Smooth Tool-ը ավտոմատ կտրում և բաժանում է գիծը մասերի։ 

3. Shape Builder Tool-ը թույլ է տալիս միավորել օբյեկտները։  

4. Line Segment Tool ստեղծում է ուղիղ վեկտորային գծեր։  

5. Perspective Selection Tool-ը թույլ է տալիս օբյեկտները տեղաշարժել 

հեռանկարային (Perspective) ցանցի վրա։  

6. Artboard Tool-ը փոխարկում է վեկտորային օբյեկտները Bitmap-ի։ 

7. Brush Tool-ը ավտոմատ ստեղծում է Gradient Mesh։ 

8. Live Paint Bucket-ը ավտոմատ ստեղծում է Clipping Mask։ 

9. Width Tool-ը  ստեղծում է երկրաչափական պատկերներ։ 
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ գունային համադրությունների  

                վերաբերյալ:  (3 միավոր) 

1. Triadic գույները հավասարաչափ տեղադրված են գունային շրջանակում։ 

2. Achromatic համադրությունը ներառում է գունային շրջանակի բոլոր տաք 

գույները։ 

3. Complementary գույները գունային շրջանակի վրա գտնվում են 90° անկյան 

տակ։ 

4. Analogous գույները գունային շրջանակում գտնվում են միմյանց կողքի։ 

5. Monochromatic համադրությունը պարունակում է միմյանց հակադիր 

գույներ։ 

6. Tetradic համադրությունը կազմված է ընդամենը երեք գույնից։ 

7. Split-Complementary գույները կազմվում են մեկ գույնի և նրա հակադիրի 

երկու հարևան գույներից։ 

8. Tonal գույները կազմված են միայն ամենավառ և հագեցած երանգներից։ 

9. Square սխեման միավորում է իրար կողք գտնվող չորս գույները։ 

 

 

Տրված պնդումներից  3-ը ճիշտ են։ Նշել դրանց համարները։ (3 միավոր) 

1. Adobe Photoshop ծրագրում Alpha Channel-ը թույլ է տալիս վերահսկել օբյեկտի 

թափանցիկությունը: 

2. Adobe Illustrator ծրագրի Live Paint Bucket Tool-ը ցանկացած օբյեկտ 

ավտոմատ վերածում է 3D մոդելի: 

3. CorelDRAW ծրագրի ֆայլը ավտոմատ պահպանվում է PSD ձևաչափով։  

4. Adobe Photoshop ծրագրում Healing Brush Tool-ը օգտագործվում է օբյեկտները 

վեկտորային ձևերի վերածելու համար:  

5. CorelDRAW ծրագրում PowerClip հրամանը թույլ է տալիս մեկ օբյեկտ 

տեղադրել մյուսի ներսում՝ պահպանելով արտաքին օբյեկտի ձևը և 

սահմանները:  

6. Adobe Illustrator ծրագրի Artboard Tool-ը օգտագործվում է տեքստային 

բլոկներին ավտոմատ անիմացիա ավելացնելու համար: 

7. Adobe Photoshop ծրագրի հիմնական աշխատանքային միջավայրը 

վեկտորային կորերն են, իսկ պիքսելներն օգտագործվում են միայն 

էֆեկտների համար: 

8. Adobe Illustrator ծրագրում Pen Tool-ը թույլ է տալիս ստեղծել մասշտաբից 

անկախ (Resolution Independent) վեկտորային գծեր և ուղիներ:  

9. CorelDRAW ծրագրի Pick Tool-ը նախատեսված է գունային պալիտրայից 

գույն ընտրելու համար: 
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HTML/ CSS-ի վերաբերյալ տրված պնդումներից  3-ը ճիշտ են։ Նշել դրանց  

               համարները։ (3 միավոր) 

1. CSS-ի display: inline; հատկությունը ստիպում է օբյեկտին սկսվել նոր տողից։  

2. CSS-ի Float հատկությունը ապահովում է, որ օբյեկտը սկսվի նոր տողից և 

զբաղեցնի ամբողջ լայնությունը։ 

3. HTML-ի <pvid> թեգը օգտագործվում է վիդեո ներմուծելու համար։  

4. HTML-ի <a> թեգը օգտագործվում է  հիպերհղումներ ստեղծելու համար։ 

5. CSS-ի color հատկությունը փոխում է էջի ֆոնը։  

6. <img> թեգը թույլ է տալիս ավելացնել պատկեր։  

7. CSS-ի padding հատկությունը ավելացնում է օբյեկտին ստվեր ։  

8. CSS-ի margin հատկությունը վերահսկում է օբյեկտի շրջապատի արտաքին 

տարածությունը։ 

9. HTML-ի <div> թեգը օգտագործվում է պարբերություններ ստեղծելու համար։  

 

 

 

 

 

 

Նշվածներից ո՞ր 3 գործողություններն են ճիշտ HTML/CSS-ի հիմնական  

                հատկությունների և թեգերի վերաբերյալ: Նշեք դրանց համարները։ (3 միավոր) 

1. CSS-ի text-center; հատկությունը բերում է օբյեկտը մեջտեղ։ 

2. HTML-ի <h1> թեգը ստեղծում է հիպերհղումներ։ 

3. CSS-ի display:inline; հատկությունը դարձնում է տարրը անտեսանելի էջում։ 

4. HTML-ի <ul> թեգը օգտագործվում է ցուցակներ ստեղծելու համար։  

5. CSS-ի font-weight հատկությունը վերահսկում է տեքստի չափը։ 

6. HTML-ի <table> թեգը թույլ է տալիս ստեղծել աղյուսակներ։  

7. CSS-ի border հատկությունը փոխում է էջի գույնը։ 

8. CSS-ի background-color հատկությունը փոխում է օբյեկտի ֆոնը։  

9. HTML-ի <form> թեգը օգտագործվում է էջում տեքստային ֆայլ ներմուծելու 

համար։ 
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Նշվածներից ո՞ր 3-ն են  ճիշտ CSS-ի վերաբերյալ։ (3 միավոր) 

1. text-paragraph-align-center; կենտրոնացնում է տեքստը տողի մեջտեղ։  

2. display: inline; ստիպում է տարրին զբաղեցնել ամբողջ լայնությունը։ 

3. width հատկությունը փոխում է տողի գույնը։ 

4. font-size հատկությունը փոխում է տեքստի չափը։ 

5. background-color-ը փոխում է տարրի եզրագիծը։ 

6. font-weight:bold; հատկությունը դարձնում է տեքստը թավ։  

7. float հատկությունը վերահսկում է եզրագծի հաստությունը։  

8. padding հատկությունը վերահսկում է օբյեկտի բովանդակության և դրա 

սահմանի միջև տարածությունը։ 

9. border հատկությունը փոխում է էջի ֆոնը։ 

 

 

 

 

Նշվածներից ո՞ր 3 գործողություններն են ճիշտ։ Նշել դրանց համարները։  

                 (3 միավոր) 

1. Secondary գույները առաջանում են Primary գույների խառմամբ։  

2. Adobe Illustrator ծրագրում Dash Offset-ը փոխում է գծի գույնը։ 

3. Sans-serif տառատեսակները չեն օգտագործվում թվային միջավայրում։ 

4. Adobe Photoshop ծրագրում Layer Mask-ը թույլ է տալիս ոչ կործանարար 

խմբագրում՝ թաքցնելով շերտի հատվածները՝ առանց դրանք իրականում 

ջնջելու։   

5. CMY մոդելը հանդիսանում է Additive գունային մոդել, որը բնութագրում է 

էկրանի լույսի ավելացումը։ 

6. Sans-serif տառատեսակները միշտ գլխատառերով են և չեն կարող ներառել 

փոքր տառեր։ 

7. Կոնստրուկտիվ գծագրության մեջ Իզոմետրիկ (Isometric) պրոյեկցիայի երեք 

հիմնական առանցքներն գտնվում են միմյանց նկատմամբ 120° անկյան տակ։ 

8. HTML-ում <div> տարրը նախատեսված է միայն տեքստային 

պարբերություններ ստեղծելու համար։ 

9. HSB/HSV մոդելում Saturation-ը վերահսկում է, թե որքան սև է ավելացվել 

գույնին՝ դարձնելով այն մուգ։ 
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